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1 Installing 
Antumbra 
iColor Keypad 
Effect Manager

Introduction
Antumbra iColor Keypad Effect Manager allows you to create light shows and 
assign the shows, which you can assign to your Antumbra iColor Keypad buttons.

This chapter provides instructions for installing Antumbra iColor Keypad Effect 
Manager on your computer. The remaining pages of this guide will show you how 
to use Antumbra iColor Keypad Effect Manager to configure your Antumbra iColor 
Keypad controllers.

Software Installation
Before installing Antumbra iColor Keypad Effect Manager, close all running 
applications, disable virus protection, and verify that your computer meets the 
following system requirements.

System Requirements
Windows® Mac OS X

• Windows 7 or higher 
• 50 MB free disk space

• Mac OS X 10.9 or higher 
• 50 MB free disk space

Installing Antumbra iColor Keypad Effect Manager
The instructions below detail how to install Antumbra iColor Keypad Effect 
Manager on your Windows or Mac OS X operating system.

To install Antumbra iColor Keypad Effect Manager on Windows:

1. Download the latest Antumbra iColor Keypad Effect Manager from  
www.colorkinetics.com/support/downloads/.

2. Unzip the file you downloaded, and then double-click the Antumbra iColor 
Keypad Effect Manager Installer folder.

3. Double-click setup.exe to launch the setup wizard.

4. Follow the on-screen instructions to complete the software installation.

After the installation is complete, launch Antumbra iColor Keypad Effect Manager 
from the Start menu.

E You can always download the 
latest version of Antumbra iColor 
Keypad Effect Manager from 
www.colorkinetics.com/support/
downloads/
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To install Antumbra iColor Keypad Effect Manager on Mac OS X:

1. Download the latest version of Antumbra iColor Keypad Effect Manager from  
www.colorkinetics.com/support/downloads/.

2. Unzip the file you downloaded, and double-click the Antumbra iColor Keypad 
Effect Manager Installer folder.

3. Double-click EffectManagerInstaller.app to launch the setup wizard.

4. Follow the on-screen instructions to complete the software installation.

After the installation is complete, launch Antumbra iColor Keypad Effect Manager 
from the Dock.



Starting Antumbra iColor Keypad 
Effect Manager
Ensure that the Antumbra iColor Keypad is installed, connected, and running. Verify 
that your computer is configured so it is able to communicate with devices on the 
lighting network.

To start Antumbra iColor Keypad Effect Manager:
1. Launch Antumbra iColor Keypad Effect Manager: 

Windows
In the Start menu, select All Programs>Philips Color 
Kinetics>Antumbra iColor Keypad Effect Manager>Antumbra 
iColor Keypad Effect Manager.

Mac OS In the Dock, click Antumbra iColor Keypad Effect Manager.

Keypad Panel Settings Panel

2.  If the “Discovery failed” message is displayed, click OK. Disconnect and 
reconnect the keypad, and then select Device>Discover Device or click the Retry 
Connection button.
If the message reappears, or if the message “Offline Demo Mode” appears in 
the status bar at the bottom of the Antumbra iColor Keypad Effect Manager 
window, verify that your keypad is installed, connected, and running, and that your 
computer IP address is properly assigned.

D To communicate with Antumbra 
iColor Keypad, your computer must 
have a static IP address. The first byte 
of your computer IP address must 
match the first byte of the keypad 
IP address (10.x.x.x., 140.x.x.x., and 
so on). Your computer subnet mask 
should be 255.0.0.0.

2 Using Antumbra iColor 
Keypad Effect Manager
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Modifying Shows
Up to six shows can be assigned to Antumbra iColor Keypad. A show consists of a 
built-in effect that is then customized and saved. To create a show, you must first select 
an effect, which you can then modify using the appropriate procedure in “Modifying 
Effects” (below).

To modify a show:
1. In Antumbra iColor Keypad Effect Manager, click a show button. The active 

button is displayed with a white dot, and the currently associated effect and its 
settings appear in the Settings panel.

2. Click the Show Settings tab.
3. Select an option from the Effect drop-down list. The options for the selected 

effect are displayed.
4. Change the effect settings as described in “Modifying Effects” (below).

Modifying Effects
After selecting an effect, continue with the appropriate procedure in this section. 
When you have finished, save changes to the Antumbra iColor Keypad.

Any actions you take in Antumbra iColor Keypad Effect Manager are immediately 
displayed on the show lights.

Effect Configuration Options
Effect Description and Options

Fixed Color
Displays a single color on all fixtures. Keypad dimming buttons adjust 
effect brightness.

Color Select an effect color using the Color Picker.

Variable 
Color

Displays a single color on all fixtures. Keypad dimming buttons 
adjust hue.

Color Select an effect color using the Color Picker.

Color Wash

Produces a smooth hue transition on all fixtures simultaneously, 
progressing through the color spectrum.

Duration Set transition time.

Saturation Set saturation value, from 0 (white) – 255 
(fully saturated).

Intensity Set intensity value, from 0 (black) – 255 (full on).

Direction Set whether colors move forward or reverse through 
the color spectrum.

C You must set your f ixture type 
before creating any shows in order 
to ensure that colors are rendered 
properly on your lights. See “Selecting 
Fixture Type” on page 15 for 
more information.

Effect drop-down list

Antumbra iColor Keypad Effects

Fixed Color

Custom Wash

Random Color

Rainbow Wash

Color Wash

Variable Color

4 Chapter 2
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Effect Description and Options

Rainbow 
Wash

Produces a smooth transition through the color spectrum. Colors 
follow each other from fixture to fixture.

Duration Set transition time.

Width Set the width of the rainbow, from 1 – 512 nodes.

Saturation Set saturation value, from 0 (white) – 255 
(fully saturated).

Intensity Set intensity value, from 0 (black) – 255 (full on).

Direction Set whether colors move forward or reverse 
through nodes.

Custom 
Wash

Produces a marching color transition across all fixtures, progressing 
through 2 – 6 selected colors. 

Color Bar Add or delete effect colors, from two to six colors.

Color Set each effect color using the RGB Range or the 
White Range.

Duration Set effect transition time.

Width Set the width of each of block of color, from 1 – 512 nodes.

Direction Set whether colors move forward or reverse 
through nodes.

Random 
Color

Displays a sequence of random colors on all fixtures, either fading or 
snapping from color to color.

Duration Set transition time.

Saturation Set saturation value, from 0 (white) – 255 
(fully saturated).

Intensity Set intensity value, from 0 (black) – 255 (full on).

Configuring Effect Settings
To modify the Fixed Color effect:

1. Select a color using the Color Picker RGB Range or White Range, as described in 
“Using the Color Picker” on page 8.

2. Click Save to commit your changes, or click Undo to remove any changes 
you made.

To modify the Variable Color effect:
1. Select a color using the Color Picker RGB Range or White Range, as described in 

“Using the Color Picker” on page 8.
2. Click Save to commit your changes, or click Undo to remove any changes 

you made.

To modify the Color Wash effect:
1. Using the Duration text box, set effect transition time.
2. Tune the displayed color using the Saturation and Intensity sliders.
3. Set the Direction in which the effect appears to move (Forward or Reverse 

through the color spectrum).
4. Click Save to commit your changes, or click Undo to remove any changes 

you made.

D Duration must be set using 
mm:ss notation.



To modify the Rainbow Wash effect:
1. Using the Duration text box, set effect transition time.
2. Using the Width controls, set the width of the rainbow, from 1 – 255 nodes.
3. Tune the displayed color using the Saturation and Intensity sliders.
4. Set the Direction in which the effect appears to move (Forward or Reverse).
5. Click Save to commit your changes, or click Undo to remove any changes 

you made.

To modify the Custom Wash effect:
1. Using the Color Bar, set the effect colors:

 ▪ To add a color swatch to the Custom Wash effect, click the + icon at the right 
of the Color Bar (maximum of six colors).

 ▪ To delete a color swatch from the effect, right-click a color swatch in the 
Color Bar, and then click Delete Color (minimum of two colors).

 ▪ To modify an effect color, select the swatch in the Color Bar and use the RGB 
Range or White Range, as described in “Using the Color Picker” on page 8. 

Color Bar

 
2. Using the Duration text box, set effect transition time.
3. Using the Width controls, set the width of each of block of color, from 

1 – 255 nodes.
4. Set the Direction in which the effect appears to move (Forward or Reverse).
5. Click Save to commit your changes, or click Undo to remove any changes 

you made.

To modify the Random Color effect:
1. Using the Duration text box, set effect transition time.
2. Tune the displayed color using the Saturation and Intensity sliders.
3. Click Save to commit your changes, or click Undo to remove any changes 

you made.

6 Chapter 2
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Notes on Fixture Configuration
Antumbra iColor Keypad broadcasts three channels of data to connected fixtures. To 
use Antumbra iColor Keypad with fixture types other than standard three-channel RGB, 
you must make sure that the fixtures are configured appropriately. You typically perform 
fixture configuration with QuickPlay Pro addressing and configuration software, or with a 
fixture’s on-board controls. Refer to specific fixture product guides for details.

Make sure that you also select the correct fixture type on the System Configuration 
tab in Antumbra iColor Keypad Effect Manager before selecting shades of white and 
tinted whites with the White Range. Antumbra iColor Keypad Effect Manager calculates 
DMX values for White Range colors based on the selected fixture type. If you change 
the fixture type, you must re-create and save any scenes that make use of White 
Range colors.

Configuring Color-Changing Fixtures with More than  
Three Channels
For reliable results, you must configure four-channel, five-channel, and IntelliHue fixtures 
to work in three-to-n-channel mode. For instance, you must configure ColorBlast TRX 
to work in RGB>RGBAW mode. 

Configuring Two- and Three-Channel IntelliWhite Fixtures
Two-channel IntelliWhite fixtures, such as iW Burst Powercore and iW Burst Compact 
Powercore, use one channel of warm white LEDs and one channel of cool white LEDs to 
produce a range of color temperatures. Three-channel IntelliWhite fixtures, such as iW 
Cove MX Powercore and iW Graze MX Powercore, add a channel of neutral white LEDs 
for greater precision in color temperature and color mixing.

IntelliWhite fixtures must be addressed in three-channel mode in order to use the Color 
Picker RGB Range to select colors for effects. In three-channel mode, the warm channel 
maps to Red, the neutral channel to Green, and the cool channel to Blue.

E Download QuickPlay Pro from www.
colorkinetics.com/support/addressing/
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Using the Color Picker
Some effects feature the Color Picker, which allows you to select specific colors of light 
for color-changing fixtures. The Color Picker offers an RGB Range for picking colors, 
and a White Range for targeting of shades or tints of white light.

Color Picker: RGB Range Color Picker: White Range
Display RGB Range Display White Range

Color Spectrum Color Detail Color Field

Color Detail 
Zoom

Favorites

Chromaticity Diagram

Active Swatch

Comparison 
Swatches

Tint Slider CCT Slider

1 2 3

Switching Between the RGB Range and the White Range
You can switch between the RGB Range and the White Range using the Display RGB 
Range and Display White Range buttons.

You can also switch between the ranges by clicking items in the Favorites list. RGB 
colors display the RGB Range, while shades of white or tinted whites display the 
White Range.

Selecting Colors with the RGB Range
The RGB Range lets you select a specific color using the Color Spectrum, Color Detail, 
and Color Field controls, or using the sliders for the RGB (red/green/blue) color model 
or the HSV (hue/saturation/brightness) color model.

The Active Swatch box shows the currently selected color. This color is also indicated 
on the Color Spectrum and the Color Field by a color point (a white dot), and on the 
Color Detail control by a highlighted box. You can change the currently selected color 
by dragging the white dot to a new location on any of the color controls, or by using 
the RGB and HSV sliders, in any combination. If lights are connected to your system and 
are turned on, they display the Active Swatch color.

To make it easier to select and fine-tune specific colors, the Color Detail control 
displays colors adjacent to the currently selected color. Using the Color Detail 
Zoom slider, you can adjust the range of colors displayed in the Color Detail control. 
When you zoom in and out, the white bounding box on the Color Spectrum shrinks 
or expands to indicate the region displayed in the Color Detail control. The more 
you zoom in, the smaller the difference between adjacent colors in the Color 
Detail control. Zoomed in

Less difference  
between adjacent colors

Zoomed out

More difference  
between adjacent colors
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Selecting a Shade of White with the White Range
The White Range targets an area within the CIE 1931 x-y chromaticity space, on which 
CCTs (correlated color temperatures) for white light are defined. To make it easier to 
select shades of white light and tinted white light, the White Range constrains color 
selections to an area along the black-body curve and the iso lines that extend above and 
below it. To select colors outside of this area, use the RGB Range.

The White Range constrains 
selections to an area along the 
black-body curve and the iso 
lines above and below it.

For colors outside the White 
Range, use the RGB Range.

 

The White Range lets you select a specific shade or tint of white using the Chromaticity 
Diagram and the Tint and CCT sliders. The currently selected shade of white appears 
in the Active Swatch. The currently selected shade is also indicated on the Chromaticity 
Diagram by a color point (a white dot), and by positions on the Tint and CCT sliders. 
You can change the currently selected shade by dragging the white dot to a new 
location on the Chromaticity Diagram, or by using the Tint and CCT sliders, in any 
combination. The CCT slider moves the color point along the black-body curve, while 
the Tint slider moves the color point perpendicular to the black-body curve, parallel 
with the iso lines. If lights are connected to your system and are turned on, they display 
the Active Swatch color.

Keep in mind that the color point and the slider positions make a general indication 
of CCT and tint, and do not imply or guarantee color accuracy or color consistency 
across different fixture types. Think of the color point and slider positions as good 
starting points. If targeting an exact color temperature or x-y coordinate is critical, 
be sure to use a light meter or other measurement device to test the output of your 
lighting fixtures.

Color definitions created with the White Range differ depending on fixture type. To 
reuse shades of white and tinted whites with different fixture types, make sure you save 
them to the Favorites list. You can then reload the colors and resave the effects when 
you change fixture types.

D The White Range helps you target 
shades and tints of white light using 
color-changing fixtures of three or 
more channels. You can also use the 
RGB Range with IntelliWhite fixtures 
in 3-channel mode. See “Notes on 
Fixture Configuration” on page 7 
for more information.

E For details on selecting fixture 
type, see “Selecting Fixture Type” on 
page 15.
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Using the Active and Comparison Swatches
Both the RGB Range and the White Range offer active and comparison swatches to make 
it easier to compare and select colors. 

The currently selected color appears in the Active Swatch. Click an item in the Favorites 
list to load that color into the Active Swatch. You can load colors into the comparison 
swatches by dragging and dropping them from the Active Swatch in either view, or from 
the Color Detail control in the RGB Range view. 

When you save settings for the Fixed Color or Variable Color effect, or when you add 
a color to the Custom Wash effect, Antumbra iColor Keypad Effect Manager uses the 
color currently loaded in the Active Swatch.

Color Picker Keyboard Shortcuts
Action Shortcut

Zoom in and out on the Color Spectrum  

(RGB Color Picker only)
Ctrl - +/Ctrl - –

Move the color point on the Color Spectrum, Color 

Detail, Color Field, or Chromaticity Diagram
///

Increase/decrease zoom on the Color Detail Zoom slider /

Increase/decrease red on the Chromaticity Diagram Ctrl - r/Ctrl - Shift - r

Increase/decrease green on the Chromaticity Diagram Ctrl - g/Ctrl - Shift - g

Increase/decrease blue on the Chromaticity Diagram Ctrl - b/Ctrl - Shift - b

Increase/decrease CCT on the CCT slider /

Move up and down the Tint Slider /

Switch between controls without moving the color point Ctrl - click or Right - click

Copy Comparison Swatch 1 color to the Active Swatch Ctrl - 1

Copy Comparison Swatch 2 color to the Active Swatch Ctrl - 2

Copy Comparison Swatch 3 color to the Active Swatch Ctrl - 3

Active Swatch

Comparison Swatches
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Saving and Undoing Changes to Shows
Adjustments made to scene colors using the Color Picker are shown on the show 
lights. It is important to remember that changes are not stored on the keypad until you 
save them.

 ▪ To save scene changes and store them on the keypad, click Save.

 ▪ To revert to the previously saved version of the scene, click Undo.

 ▪ While working in a show, if you switch to another show or exit Antumbra iColor 
Keypad Effect Manager, any unsaved changes are lost.

Using Favorites
The Favorites list, located on the right side of the Show Settings tab, contains colors that 
are saved for later use in Antumbra iColor Keypad Effect Manager. These Favorites are 
organized into User Groups.

By default, Antumbra iColor Keypad Effect Manager offers two User Groups that cannot 
be modified:

 ▪ PCK Swatches includes 12 RGB colors and 20 shades or tints of white.

 ▪ Apollo Gel Swatches includes colors matched to Apollo color catalog offerings.

Selecting colors in the Favorites lists:
 ▪ Click an RGB color in the Favorites list to display the RGB Range and load the 

selected color into the Active Swatch.

 ▪ Click a White Range color in the Favorites list to display the White Range and load 
the selected color into the Active Swatch. White Range colors are indicated by a 
white triangle in the upper right corner of the swatch icon.

 ▪ Type a string of text in the Filter text box to limit the Favorites list to only those 
colors whose names contain the search string. Click  to clear the search string and 
display all available colors.

Working with User Groups:
 ▪ Click the name of a User Group to expand or collapse that group.

 ▪ To create a new User Group, click the Create a New User Group button above the 
Favorites list. The new User Group is located at the bottom of the Favorites list.

 ▪ To rename a User Group, double-click the User Group name, and enter a new name.

 ▪ To delete a User Group, right-click the User Group, and then click Delete.

Working with custom Favorites:
 ▪ To create a new Favorite, select a color and click the Add to User Group button. The 

new Favorite appears with a default name (Color, Color 2, Color 3, and so on) in the 
default User Group in the Favorites list. If there are no user-created User Groups 
available, a new one will be created for you.

 ▪ To rename a Favorite, double-click a Favorite, and then enter a new name.

 ▪ To delete a Favorite, right-click a Favorite, and then click Delete.

RGB color

User Group

Add to User GroupWhite Range color

Export Selected Swatches
Import Swatches

Create a New User Group

Filter
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Importing and exporting custom Favorites:
 ▪ To export, select one or more Favorites, and then click the Export Selected 

Swatches to a File button. Enter a file name and location, and then click Save. The CK 
Color File export is saved to your computer with the .ckcolors extension.

 ▪ To import, click the Import Swatches From a File to a New User Group button. 
Select a CK Color File (.ckcolors extension) from your computer, and then click 
Open. A new User Group containing the imported Favorites is created in the 
Favorites list.

Changing Keypad Configuration
The options in the System Configuration tab allow you to change Antumbra iColor 
Keypad behavior and network settings. This section details all configuration options.

Changing the Keypad Name
To differentiate your keypad from other devices on the lighting network, you can change 
its name.

To change the keypad name:
1. Click the System Configuration tab. 
2. Enter a new name in the Name text box.
3. Click Save.

E To select multiple Favorites for 
export, hold down the [Ctrl] key 
(Windows) or the [Command] 
key (Mac OS X) while clicking the 
Favorites you intend to export.



Changing the Keypad IP Address
Antumbra iColor Keypad comes factory-set with a unique IP address, which you can 
change at any time.

To change the keypad IP address:
1. Click the System Configuration tab. 
2. Enter a new IP address in the Address text box.
3. Click Save.
4. If Antumbra iColor Keypad Effect Manager does not automatically rediscover 

your keypad, click Device>Discover Device.

Setting KiNET Mode
KiNET is a high-performance Ethernet protocol engineered by Philips Color Kinetics 
for LED lighting control.

Most Philips Color Kinetics devices can use KiNET v2. However, some devices, such as 
PDS-150e power/data supplies, are compatible only with KiNET v1.

About KiNET v1 and KiNET v2
KiNET v1 treats an individual power/data supply as a single DMX universe, regardless of 
the number of ports it contains. Using KiNET v1, up to 170 nodes (510 channels) can 
connect to a power/data supply, even if it contains several ports.

KiNET v2 treats each individual port as its own DMX universe. For example, sPDS-
480ca 7.5 V has 16 ports and can support up to 1,152 nodes (3,456 channels) to the 
power/data supply.

Antumbra iColor Keypad broadcasts show data using the KiNET v2 protocol by default. 
Most users will not need to change this setting.

To set KiNET mode:
1. Click the System Configuration tab.
2. Enter 1 or 2 in the KiNET Mode box.
3. Click Save.

Setting the KiNET Universe
By default, Antumbra iColor Keypad controls KiNET universe 0 (zero). All Philips Color 
Kinetics power/data supplies also come factory-set to KiNET universe 0. If the KiNET 
universe of a connected power/data supply has been changed, you must change the 
Universe setting of your keypad to match it.

To set the KiNET universe:
1. Click the System Configuration tab. 
2. Enter a new universe number (0 – 255) in the Universe box.
3. Click Save.

D The first byte of your computer 
IP address must match the first byte 
of the keypad IP address (10.x.x.x., 
140.x.x.x., and so on).

E Most installations will not need 
to make use of this feature, and we 
recommend leaving the Universe value 
set to 0.
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Setting the Number of Ports
You will need to configure this setting if Antumbra iColor Keypad is used in KiNET v2 
installations. If your keypad is set to KiNET v1, you do not need to change this setting.

The value in Number of Ports should equal the maximum number of ports on a single 
power/data supply. To ensure optimal operation, ports should be utilized in sequence 
on each power/data supply, starting with port 1. For example, on sPDS-480ca, connect 
your lights to ports 1 and 2 before continuing to ports 3 through 6.

To set the number of ports on your power/data supplies:
1. Determine the largest number of ports on a single power/data supply on your 

lighting network, and write down that number. For example, sPDS-480ca 7.5 V 
supplies have 16 power ports, so you would write down “16.”

2. Click the System Configuration tab in Antumbra iColor Keypad Effect Manager.
3. Enter the number that you wrote down from step 1 into the Number of 

Ports box.
4. Click Save.

Setting Lights Per Power/Data Supply Port
By default, Antumbra iColor Keypad broadcasts show data for 72 sequentially 
addressed nodes per port. If more than 72 nodes are connected to any port on any of 
your power/data supplies, you need to increase this setting to the appropriate value.

Up to 170 three-channel nodes can be connected to a single port.

To set the number of lights per port:
1. Determine the largest number of nodes connected to a single port on your 

lighting network, and write down that number. This number cannot be greater 
than 170.

2. Click the System Configuration tab in Antumbra iColor Keypad Effect Manager.
3. Enter the number that you wrote down from step 1 into the Lights per Port box.
4. Click Save.

Setting Network Broadcast Mode
Antumbra iColor Keypad comes factory-set to broadcast show data to all devices on 
your lighitng network. You may instead wish to send show data to a single power/data 
supply. To do this, change the network mode to unicast.

To change the network broadcast mode:
1. Click the System Configuration tab.
2. Select the desired broadcast behavior in the Network Mode group box:

 ▪ To broadcast show data to all power/data supplies on your lighting network, 
select Broadcast.

 ▪ To transmit show data to a single power/data supply on your lighting network, 
select Unicast, and type the IP address of the intended device in the text box.

3. Click Save.

14 Chapter 2
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Selecting Fixture Type
For reliable results, you must select the fixture type used in your installation. This must 
be done before saving White Range colors in the Color Picker. 

Antumbra iColor Keypad Effect Manager creates DMX values for White Range colors 
based on the selected fixture type. If you change the fixture type, you must re-create and 
save any scenes that make use of White Range colors.

To select fixture type:
1. Click the System Configuration tab. 
2. Select your fixture type from the Fixture drop-down list.
3. Click Save.

Configuring Button Behavior Settings
Antumbra iColor Keypad Effect Manager allows you to change settings that control 
behavior of the AntumbraTouch or AntumbraButton panel. Available options are 
detailed below.

To change button mode:
1. Click the System Configuration tab.
2. Select one of the following Button Mode options:

Mode Button Behavior

6 Shows  
on/off

Shows are assigned to all six buttons.
• Press the active button to turn the show lights off.
• Dimming functionality is disabled on this keypad.

4 Shows 
discrete 
dimming

Shows are assigned only to the buttons in the top two rows.
• Press and release the active button to turn show lights off.
• Press the lower left or lower right button to increase or 

decrease brightness of show lights, respectively.

6 Shows hold 
to dim

Shows are assigned to all six buttons.
• Press and release the active button to turn show lights off.
• Press and hold the active button to alternate between 

increasing and decreasing brightness of show lights.

3. Click Save.

To change the startup show:
1. Click the System Configuration tab.
2. Select an avaailable option from the Startup Show drop-down list.
3. Click Save.

To enable or disable AntumbraTouch auditory feedback:
By default, the AntumbraTouch panel will beep when a button is pressed. You can 
enable or disable this beep from the Antumbra iColor Keypad Effect Manager system 
configuration options.

1. Click the System Configuration tab.
2. If you want the AntumbraTouch panel to beep when a button is pressed, select the 

Sound on Keypress check box. If you do not want the AntumbraTouch panel to 
beep when a button is pressed, clear the Sound on Keypress check box.

3. Click Save.

D See “Notes on Fixture Configuration” 
on page 7 for details on configuring 
different types of fixtures in 
an installation.

D This setting only affects 
AntumbraTouch panels.
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To lock or unlock the keypad:
By default, Antumbra iColor Keypad is unlocked. To limit access to keypad functions, 
you can lock the keypad from the Antumbra iColor Keypad Effect Manager system 
configuration options.

1. Click the System Configuration tab.
2. To lock the keypad, select the Panel Lock Out check box. To unlock, clear the 

Panel Lock Out check box.
3. Click Save.

To enable or disable Night Mode:
If Night Mode is enabled, the keypad backlight will glow in low light settings, allowing you 
to easily find the keypad in the dark. If Night Mode is disabled, the keypad backlight will 
turn off completely when the keypad is not in use. Night Mode is enabled by default.

1. Click the System Configuration tab.
2. To enable Night Mode, select the Night Mode check box. To disable, clear the 

Night Mode check box.
3. Click Save.

To enable or disable the Proximity Sensor:
1. Click the System Configuration tab.
2. To enable the Proximity Sensor, select the Proximity Sensor check box. To disable, 

clear the Proximity Sensor check box.
3. Click Save.

To enable or disable individual keypad buttons:
By default, all keypad buttons are enabled. One or more of the six show buttons can be 
disabled if you do not need use of them. You must have at least one enabled button.

1. Click the System Configuration tab.
2. To enable a button, select the check box next to the intended button. To disable, 

clear the check box next to the intended button.
3. Click Save.

Selecting a Network
If your computer has multiple network interface cards (NIC) to manage multiple 
networks, you can select the network interface that is connected to your lighting 
system network.

To select a network:
1. Click the System Configuration tab.
2. Do one of the following:

 ▪ To allow your computer decide which NIC to use, select Use default interface.
 ▪ To manually choose the NIC that is connected to your lighting network, click 

Use selected, and then select the desired NIC from the list.

D Buttons that are disabled using 
Antumbra iColor Keypad Effect 
Manager can still be used to lock and 
unlock the keypad. 

Enabled keypad button

Disabled keypad button

The Network tab
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Restoring Factory Default Settings
You may want to restore the factory default settings for your keypad. If you do this, all 
saved changes to shows and system settings will be overwritten with the default settings, 
except for IP address and keypad name.

To restore the factory default settings:
1. Select Device>Restore Factory Default Settings.
2. Click Yes to restore default settings.

Saving and Loading Configuration Files
A configuration file contains all show settings and configuration information except for 
your keypad name and IP address. You can save custom settings in a configuration file, 
which can be used to program multiple devices.

To save a configuration file:
1. Select File>Save Configuration File to save current keypad settings. 
2. Specify the configuration file name and location, and then click OK. 

To load a configuration file:
1. Select File>Load Configuration File to load saved keypad settings. 
2. Navigate to a location containing a valid configuration file, select the file, and 

click Open.

D When loading a configuration 
file, brightness is automatically set 
to 100%.
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Locking the Keypad
You can lock and unlock Antumbra iColor Keypad to prevent 
unauthorized or accidental control of your lighting installation.

To lock the keypad:
1. Press and hold two opposite corner buttons (either the top left and 

bottom right buttons, or the top right and bottom left buttons). 
Keep your fingers in place while the indicator LEDs chase each other 
clockwise around the keypad. 

2. When all the indicator LEDs pulsate in unison, remove your fingers 
from the keypad. The keypad is now locked; pressing any of the 
buttons will have no effect on your lights.

To unlock the keypad:
1. Press and hold two opposite corner buttons. Keep your fingers in 

place while the indicator LEDs chase each other counterclockwise 
around the keypad. 

2. When all the indicator LEDs pulsate in unison, remove your fingers 
from the keypad. The keypad is now unlocked, and you can now 
control your lights.

Controlling Your Lights
Antumbra iColor Keypad can play up to six preconfigured shows, dim your lights, 
or turn your lights off.

To play a show:

Press and release a keypad button to play a show. The selected show will play, 
and the indicator LED for the active button will remain illuminated.

To dim your lights in 6 Shows hold to dim mode:

1. Locate the active button (where the indicator LED is lit) on the keypad.

2. To fade your lights down, press and hold the active button. Your lights will 
decrease in brightness until you release the button.

3. To fade your lights up, press and hold the active button again. Your lights 
will increase in brightness until you release the button.

4. Repeat the previous two steps, as needed, until your lights are set to the 
desired brightness.

D If your keypad is set to  
6 Shows on/off mode, dimming 
functions are not available.

D If the current show is using 
the Variable Color effect, keypad 
dimming functions will adjust 
hue instead of brightness.

3 Using Antumbra 
iColor Keypad
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To dim your lights in 4 Shows discrete dimming mode:

1. To fade your lights down, press and hold the bottom left button. Your lights 
will decrease in brightness until you release the button.

2. To fade your lights up, press and hold the bottom right button. Your lights 
will increase in brightness until you release the button.

To turn your lights off:

1. Locate the active button (where the indicator LED is lit) on the keypad.

2. Press and release the active button. Your lights will turn off.

3. To turn the lights back on, press and release any keypad button that has an 
assigned show.



Updating Antumbra iColor Keypad 
Effect Manager
Antumbra iColor Keypad Effect Manager is periodically updated with new 
features. You can check for updates whenever you like, or you can set Antumbra 
iColor Keypad Effect Manager to automatically notify you of available updates.

To update Antumbra iColor Keypad Effect Manager:

1. Select Help>Update....

2. To check for updates now, click Check For Updates Now.

3. To automatically check for updates, select the Automatically check for 
updates check box, and enter the frequency that you want to check for 
updates, in days. 

4. If you use a proxy server to connect to the Internet, select the Use a proxy 
to access the internet check box, and enter the proxy information.

5. Click OK.

Updating Antumbra iColor 
Keypad Firmware
Antumbra iColor Keypad firmware is periodically updated to improve device 
performance and functionality. To maximize system performance, make sure 
your Antumbra iColor Keypad devices are running the most recent version of the 
firmware. 

To download Antumbra iColor Keypad Firmware:

If a more recent version of the Antumbra iColor Keypad firmware is available, 
download the firmware file (.hex extension):

1. Visit the Firmware Updates page at www.colorkinetics.com/support/
downloads/firmware/ to check for the latest firmware version. 

2. If a newer firmware image is available, click the link on the Firmware 
Updates page to download the firmware file to an accessible location on 
your computer.

To download CK Firmware Updater:

Before you can update the firmware on an Antumbra iColor Keypad device, 
you must download and install the CK Firmware Updater application on 
your computer.

E Download new versions 
of Antumbra iColor Keypad 
Effect Manager at any time 
by visiting www.colorkinetics.
com/support/downloads/.

D You can check the 
firmware version number 
currently installed on 
Antumbra iColor Keypad from 
the System Configuration tab 
in Antumbra iColor Keypad 
Effect Manager. 

4 Updating
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1. Visit the Firmware Updates page at www.colorkinetics.com/support/ 
downloads/firmware/

2. Download the Firmware Updater Utility.

3. Decompress the file to an accessible location on your computer and open it.

4. Run the installer, and follow the on-screen instructions.



 Antumbra iColor Keypad Effect Manager  User Guide 23



Color Kinetics
www.colorkinetics.com

© 2019 Signify Holding. All rights reserved. Specifications are subject to change without notice. No representation or warranty as 
to the accuracy or completeness of the information included herein is given and any liability for any action in reliance thereon is 
disclaimed. All other trademarks are owned by Signify Holding or their respective owners. Throughout this brochure, installation 
photos of Color Kinetics lighting products are featured—and in minor instances, products from other companies may be included in 
those photos.

PUB-000389-01 R01 11-18


